
 

 

 

                     

            

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 مجلة وحدة خدمة المجتمع
 تصدر عن     

 المستمروحدة خدمه المجتمع والتعليم 

 هـ1439-1438للعام الجامعي           

 م                            2018-2017

 )العدد الأول(                      

 م2017ديسمبر  -هـ 1439ربيع الأول            

                               

 

W W W . A S B C . Q U . E D U . S A 

 

 المملكة العربية السعودية

 وزارة التعليم

 كلية الآداب والعلوم بالبدائع

 وحدة خدمة المجتمع والتعليم المستمر



 

 رةــفك                            

 عبد القوي عبده رانيا الصاوي /د                         

 أستاذ الصحة النفسية 

 بكلية الآداب والعلوم بالبدائعرئيسة وحدة خدمة المجتمع         

 

 عدادإ                            

 عبد القوي د/ رانيا الصاوي عبده                        

 أ/سارة إبراهيم الفريح

 ذتنفيــ                            

 الفريحإبراهيم سارة أ/                               

 البدائعكلية الآداب والعلوم بسكرتيرة وحدة خدمة المجتمع ب        

 المشاركون                        

 د/ رحاب أحمد -2             د/ حامدين عبد الواحد -1

 د/مشاعر محجوب -4بيف                      زليخةد/  -3

 أ/أفراح المطيري -6                    أ/ رشا الجزار -5    

     

 

 

 



 

 مقدمة

  بسم الله الرحمن الرحيم

شكره نحمده تعالى ون الذي أنار عقولنا ويسر طريقنا وشغل أوقاتنا بما ينفعناالحمد الله   
وصحبه  آلهالمتقين وعلى  ماموإالمرسلين  ونصلي على نبيه محمد صلى الله عليه وسلم سيد

 وبعد: أجمعين.
 

 في الجامعة،عمادة خدمة المجتمع والتعليم المستمر تقوم وبدعم كبير من إدارة  أننجد 

                                                                                 تطوير العلاقة  مع المجتمع ومختلف قطاعاته بهدف الاستجابة لمتطلباته وتلمس احتياجاته، 

 لجامعةوإمكانات ا                                                                  من خلال تفعيل دور الشراكة بينهما، وليستفيد المجتمع  أيض ا من قدرات 

 ،تخصصاتهافي مختلف 

دمة من ع المقتختص وحدة خدمة المجتمع بالتخطيط والتنظيم لتنفيذ أنشطة خدمة المجتمو

عديد من وفيها يتم تنظيم ال الكلية ومنسوباتها بهدف الارتقاء بالخدمات التي تقدم للمجتمع

 المجتمع.مجموعة من الندوات والمعارض التي تخدم والدورات التدريبية 

بين ضع أن تفي كلية الآداب والعلوم بالبدائع خدمة المجتمع والتعليم المستمر وحدة يسر و
وذلك  ة،البشريخبراتها وإمكاناتها في مجال تدريب وتنمية الموارد مجلة نوضح فيها  أيديكم

                                                                           مساهمة منها في تطوير قدراتهم ورفع ا لكفاءاتهم لتحقيق أهداف الخطط التنموية.
 

 .السداد لما يحبه ويرضاهسائلين المولى التوفيق و

 

 

 

 

 

 

 

 

 

 



 

 

 العميدةكلمة 

فكل  المهمة، أنماطها أحدة نرى أن خدمة المجتمع هي مالمجتمعات المتقدفي قراءه سريعة لأوضاع 

لجميع ه بحيث يصبح اكبيرا يحمل مسؤولية تجاه المكان الذي يعيش في أوفرد في المجتمع صغيرا 

 المجتمع.عضوا فعالا لتطوير 

مجتمع المؤسسة لتطوير ال أوتعني تلك الخدمات التي يقدمها الفرد  أنهاوفي تعريف خدمة المجتمع نرى 

المجتمع من تقديم ما يضمن رقي  أفرادتمكين جميع  أنكما  فرضا،تطوعا أو  هذه الخدمةسواء كانت 

ويتضح هذا الوعي في  الجميع،يكون عليه  أنوتطور هذا المجتمع لهو دليل على الوعي الذي يجب 

ة الموجهة للمجتمع والتي ينفذها شريحالخدمية  الأعمال أشكالحيث كثرت  الأخيرةمجتمعنا في الفترة 

 أوطلبة مدارس  أومختلفة  إداراتفي  أفراداسواء كانوا  وإناثهذا الوطن من ذكور  أبناءكبيرة من 

 غيرهم.

في  في نشر ثقافه المشاركة الإيجابيحكومتنا الرشيدة هذا الجانب بالغ اهتمامها لتأثيره  أولتولذلك 

واللحاق بمصاف الدول في هذا  بالأمةوعي لدى الجميع للنهوض دفع عجلة التطور ورفع مستوى ال

 المجال.

 

 

 

 كلية الآداب والعلوم بالبدائععميدة                                                                      

 

 العتيبيسعد فهمية د/                                                                      

 

 

 

 

 

 

 

 



 

 

 

 كلمة الوكيلة

جدها من ن الأفرادت الذي ترفع فيه كفاءه قي الوفف الإنسانية،المهن التي تخدم  نخدمة المجتمع مهنه م

 تهتم بربط الفرد بالمجتمع الذي يعيش فيه وكذلك البيئة التي أنهاكما  التعليم.ترفع كفاءه  أخرجانب 

 إلىفقط  فالمجتمع لا يحتاج  والمجتمع.فاعليه في البيئة  أكثر أفرادليها وذلك للحصول على إ ينتمي

 ،النبيل الأخلاقييكون على درجة من الرقي والتحضر والسمو  أن إلىيحتاج  أنماالخدمات المالية 

والجماعات  الأفرادخدمة المجتمع تساهم على نطاق واسع في حل المشاكل وحماية  أننجد  كلذل

 المجتمعي.ر الاستقرا إلىوالوصول بهم 

دون أي مقابل وكان التشجيع حليف بتقدم  وأصبحت الأخيرةلقد ازدهرت خدمة المجتمع في السنوات 

 رفةالمعتدرس بالجامعات كتخصص منفصل من اجل زيادة  أصبحتونظرا لأهميتها  عليها،من يقدم 

اس قيق مصالح النمكتف في جميع مجالاته العلمية والعملية قادر على تحلمجتمع واع               بها. فهنيئا  

 واحتياجاتهم.

 

 

 

 وكلية كلية الآداب والعلوم بالبدائع                                                                     

 

 د/أمل بنت صالح الشريدة                                                                      

 

 

 

 

 

 

 

 

 

 



 

 القصيمنبذه عن جامعه 

  الرؤية:

 .المعرفة في بناء مجتمع مسهمه القصيم،داعمة للتنمية المستدامة في  التعليم،                       جامعة متميزة وطنيا  في   

  

  الرسالة:

وتقديم  عمل،التفي باحتياجات سوق  التأهيلتوفير تعليم جامعي متطور ومعتمد لإعداد كفاءات متكاملة 
 المعرفي، ادالاقتصبما يرقى بالمجتمع المحلي وسهم في بناء  متميزة،خدمات مجتمعية وأبحاث تطبيقية 

وذلك باستخدام أحدث الأساليب الإدارية والتقنية والمعلوماتية وتفعيل الشراكة الوطنية والدولية وتنمية 
 الجامعة.موارد 

  

  القيم:

 ي:بالآتجامعة القصيم وحدة خدمة المجتمع بتؤمن  ،الإسلاميةبالقيم  الالتزامفي ضوء 

 :لتحقيق مقومات العدالة وتساوي الفرص والنصاف في التعامل مع الجميع نسعى العدالة. 

  :والأخلاقيات المهنية بالأدبنؤدي العمل بإخلاص ونلتزم الأمانة. 

 :بالإفصاح في المعاملات الإجراءات وتدعيم متطلبات المساءلة والنزاهة نلتزم الشفافية. 

 :وخدماتنااعلي معايير الجودة في كافة الأعمال بما يميز مخرجاتنا  تطبيق الجودة. 

 اريالابتكالتفكير الإبداعي والسلوك  علىالجامعة لمناخ التنظيمي المحفز  تهيئ :الإبداع. 

  وسلوكا                                           ترسخ الجامعة ثقافة العمل الجماعي تفكيرا   الجماعي:العمل        . 

  لأخريناوالتفاعل مع  والانفتاح الاستكشافيةمية تشجع الجامعة الممارسات العل العلمية:الحرية. 

 

 

 

 

 

 



 

 البدائعبالآداب والعلوم  نبذة عن كلية
 

 الكلية:نشأة 

تعتبر كلية الآداب والعلوم بمحافظة البدائع إحدى الكليات التي تم افتتاحها بجامعة القصيم بقرار من  
هـ وتوج بالموافقة السامية رقم 12/12/1432وتاريخ  125/124/1432مجلس التعليم العالي رقم 

 والترجمة، الإنجليزيةأقسام هي اللغة  هـ، وتضم خمسه14/45/1433وتاريخ  1425/145/456
والتي تهتم بخدمة الطالبات في العديد من  النفس.علم  الفيزياء، الآلي،الرياضيات، الحاسب 

التخصصات وتسهم في تزويد الطالبات بالمعارف والمهارات العلمية والعملية بالإضافة إلى بناء 
 قدراتها.شخصية الطالبة وتنمية 

وتسعى الكلية من خلال الإمكانات المتاحة لديها على تقديم تعليم نوعي متميز لطالباتها بما يتفق مع 
معايير الجودة والاعتماد الأكاديمي في التعليم العالي، وبما يحقق رؤية ورسالة الجامعة من حيث 

متوافقة  حيث تكون                                                                        التميز في التعليم وطنيا . ولقد حرصت الكلية في وضع خطط برامجها الدراسية ب
 لها.مع مثيلاتها من البرامج في الأقسام المرجعية المناظرة 

 الرؤية: 

 لمستدامة.اداعمة للتنمية المحلية  المجتمعية،والمشاركة  التعليمية،                         التميز وطنيا  في العملية   

 الرسالة:

عليم جامعي تقديم ت والمعاصرة،                                                              توفير تعليم شرعي معتمد أكاديميا ومتميز بحثيا  يجمع بين الأصالة  
لإعداد كفاءات علمية تلبي احتياجات سوق العمل  الأساسية،متميز ومعتمد في مجال الآداب والعلوم 

باستخدام أحدث الأساليب التقنية وتنمية الموارد وتفعيل الشراكة  المعرفة،وتسهم في بناء مجتمع 
 .المجتمعية

 هداف:الأ

 .التخصصات والحصول على الاعتماد الأكاديمي الوطني والدوليرفع جودة التعليم في جميع  .1

 .رفع الجدارة والقدرة التنافسية للطلاب .2

 .تفعيل البحوث التطبيقية والشراكة المجتمعية لتلبية متطلبات التنمية .3

 .رفع الأداء الإداري والتقني والمعلوماتي المؤسسي .4

 .والوطنية والدوليةتعزيز التعاون والشراكة مع المؤسسات المحلية  .5

 .رفع معدلات كفاءة واستبقاء الموارد البشرية .6

                   

 

 



 

 خدمة المجتمع وحدة عمادةنبذة عن 

 العمادة:نشأة 

                                                                                    أنشئت عمادة خدمة المجتمع بناء  على موافقة مجلس الجامعة بجلسته الثانية للعام الجامعي 

                                                      هـ وذلك حرصا  من وزارة التعليم العالي على تهيئة خدمات  1425/  3/  22هـ بتاريخ 1425/1424

ا وسيط ا يربط بين الجامعة ميع وج                                                                                      الجامعة للمجتمع .وتعد عمادة خدمة المجتمع بجامعة القصيم جهاز 

لتي ا الاستراتيجية                                                                       قطاعات المجتمع ومؤسساته وانطلاق ا من أهداف جامعة القصيم ورسالتها وخطتها 

                                                                                         تركز على خدمة المجتمع، وإسهاما  من العمادة في تلبية احتياجات المجتمع تقوم من خلال الخبرات 

ة متخصصة في مختلف حقول المعرف تت التي تمتلكها الجامعة بتقديم دبلومات علمية ودوراوالكفاءا

 العلمية والتقنية والتدريبية، لتساهم في تلبية وتنمية احتياج المجتمع وتطلعاته.

 الرؤية:

 .ومتكاملة                                                                 عمادة خدمة مجتمع متمي زة وطنيا  في تقديمها لخدمات مجتمعية نوعي ة 

 الرسالة:

 حتياجاته،اتقديم خدمات تعليمية وتدريبية واستشارية وبحثية تطبيقية لخدمة المجتمع المحلي وسد 

ق يسهم في تحقي استراتيجي منظوروفق  الصلة،وتدعيم قنوات التعاون والشراكة مع الجهات ذات 

 لتقنيات.وا الأساليب أحدثوذلك بتوفير بيئة عمل محفزة واستخدام  أهداف التنمية المحلية المستدامة

 العمادة:فلسفة 

 على:تنطلق العمادة من خلال شعارها )الحياة سباق( من فلسفة ترتكز 

 المجالات.الإيمان بأن الإنسان قادر على النهوض بمجتمعه في مختلف  .1

 لذلك.الثقة بأن الإنسان مهيأ لتطوير قدراته ومهاراته إذا ما أتيحت له الفرصة  .2

 العمل.تأكيد التوجه الوطني في استغلال إمكانات وقدرات الإنسان وتهيئته لسوق  .3

   المجتمع.تحفيز التفاعل الإيجابي بين إمكانات الجامعة وكلياتها ومؤسسات  .4

 .المتغيراتصناعة الإنسان الذي يؤمن بالمسلمات ويتعامل بروح عصرية مع  .5

 

 



 

 القيم:

 

وثقافتنا الراسخة المستمدة من تعاليم ديننا الإسلامي والتي تنطلق قيم العمادة من ثوابتنا 

 تقوم على:

نسعى لتحقيق مقومات العدالة وتساوي الفرص والإنصاف في التعامل مع الجميع. العدالة: -  

نؤدي العمل بإخلاص ونلتزم بالآداب والأخلاقيات المهنية. الأمانة: -  

والنزاهة.نلتزم بالإفصاح في المعاملات والإجراءات وتدعيم متطلبات المساءلة  الشفافية: -  

    نطبق أعلى معايير الجودة في كافة الأعمال بما يميز مخرجاتنا وخدماتنا.  الجودة: -

تهيئ العمادة المناخ التنظيمي المحفز على التفكير الإبداعي والسلوك الابتكاري. الإبداع: -  

                                                  ترسخ العمادة ثقافة العمل الجماعي تفكيرا  وسلوكا . عي:الجماالعمل  -

    

 

 

 

 

 

 

 

 

 

 

 

 



 

 ( 381للفصل الدراسي الأول ) بالبدائع المجتمع إنجازات وحدة خدمة

والعلوم بالبدائع بتفعيل الأنشطة التالية  الآدابالعلمية والأدبية بكلية  الأقسامقامت 

 المجتمع:لوحده خدمة 

 النشاط القسم

خدمة وحدة 

 المجتمع

 للتعريف بأنشطة خدمة المجتمع. الأقسامتم عقد اجتماع مع منسقات  -1

 الأقسامتم عمل مطوية بأهداف ورؤية ورسالة وحدة خدمة المجتمع وتوزيعها على  -2

  وأنشطتهاللتعريف بالوحدة 

 علم النفس

 عامة لتنمية الوعي بأنشطة خدمة المجتمع بالكلية. ةمحاضر إقامةتم  -1

 قود حياتي لأصنع النجاح.دورة تطويريه بعنوان أ تم عمل -2

 تم عمل دورة بعنوان كيف تكتسبي مهارة الثقة بالنفس. -3

 الرياضيات
 (استخدام أساليب بحوث العملياتدورة بعنوان ) إقامةتم  .1

 مفهوم مشكلة التخصيص()عن ورشه عمل لطالبات قسم الرياضيات  إقامةتم  .2

 الفيزياء

الفيزياء حياتنا اليومية ودورها في خدمة  أهميةعمل ندوة تثقيفيه بعنوان تم  -1

 .مطويه بموضوع الندوة إعدادالمجتمع وتم 

عن  مطوياتوتم توزيع  بعنوان )نحو بيئة أفضل( حمله توعيه إقامةتم  -2

 الحملة.موضوع 

الحاسب 

 الآلي

دورة لأعضاء هيئه التدريس الغير ناطقين باللغة العربية بعنوان  إقامهتم  -1

 البوربوينت( إعدادكيفية )

 للموظفات والطالبات. create a table ))  دورة بعنوان إقامهتم  -2

اللغة 

 الإنجليزية

 وتم توزيع مذكرة الإنجليزيةاللغة  أساسياتدورة للموظفات لشرح  إقامةتم  -1

 عن موضوع الدورة.

تم زيارة مدرسه ثانويه لتوعية الطالبات بالأقسام المتاحة بكلية الآداب -2

 والعلوم بجامعه القصيم فرع البدائع.

 



 

 النفس:قسم علم  نشطةموجز لأ

 مهارة الثقة بالنفسكيف تكتسبي دورة  -1

 د/ مشاعر محجوب.. أستاذ مساعد تربوي/ جنائي

 دورة:محتويات ال
 تعريف الثقة بالنفس  •

 أهميتها  •

 أنواعها •

 منظومة الثقة بالنفس ومستوياتها •

 مقارنة بين الثقة بالنفس الغرور •

 الهدي النبوي لبعث الثقة بالنفس •

 خطوات اكتسابها •

 تمارين عملية  •

 :تعريف الثقة بالنفس

الثقة بالنفس هي حسن اعتداد المرء بنفسه واعتباره لذاته وقدراته حسب الظرف الذي هو فيه 

(. خضوع غير محمود أوذلة  )منودون تفريط  عناد( أوكبر  أو )عجب إفراطدون  الزمان( )المكان،

مقدار من الثقة بالنفس  إلىيستغني عن الحاجة  إنسانامر مهم لكل شخص مهما كان ولا يكاد  وهي

 . الأمورفي امر من 

ز حول وعدم التمرك والقناعةله وكذلك شعوره بالكفاءة والجاذبية  الآخرينشعور الفرد بتقبل  هي:و

 الذات.

 الثقة بالنفس: أهمية

الثقة بالنفس في التحصيل الدراسي وفي مختلف جوانب حياة  لأهميةتشير  دراسات كثيرةهناك 

هناك علاقة ارتباطية موجبة  أنمن اهم نتائج هذه الدراسة  دسوقي كانالفرد فمثلا في دراسة محمد 

بين التحصيل الدراسي وبعض سمات الشخصية وكان من بين هذه السمات سمة  إحصائيةذات دلالة 

 ائيةإحصفي دراسة لويس تيرمان كان من اهم نتائجها وجود فروق ذات دلالة  بالنفس. وأيضاالثقة 

بين المتفوقين وغير المتفوقين في بعض سمات الشخصية كان من بينها سمة الثقة بالنفس لصالح 

 .المتفوقين



 

 الثقة بالنفس بالصحة النفسية: علاقة

الصحة النفسية  أنهناك علاقة وثيقة بين الثقة بالنفس وبين الصحة النفسية ذلك  أنالدراسات  أثبتت

 هو الثقة بالنفس فالشخص الصحيح نفسيا يستمتع بالثقة بنفسه بينما الشخص أساسيتستلزم شرط 

كون نقطة ت إنماكل مرض نفسي  أن تاما، ونجدتنعدم انعداما  أوالمريض نفسيا تضعف ثقته بنفسه 

 البداية فيه هي فقدان الثقة بالنفس.

جانب  لىإالغالبية العظمى من الجهود التي يبذلها المعالج النفسي بقصد رد المريض نفسيا  أنونجد 

عقل  لىإعلى المحاولات التي تتعلق برد الثقة بالنفس  الأولىالصحة النفسية تتركز بالدرجة 

سي فان على الطبيب النف أنفسهم أصحابها لا يعرضبالنسبة للحالات التي  ووجدانه وحتىيض المر

 فقدان تكامله النفسي. يدل على إنماكثير من ثقته بنفسه  إلىافتقار الشخص  أوفقدان الثقة بالنفس 

لارتياح االفرد بالسعادة والسعادة حالة نفسية من  بإحساسكما ترتبط الثقة بالنفس ارتباطا وثيقا 

 .والثقة بالنفس بالطمأنينة الإحساسعلى  أساسيةترتكز بصفة 

 العمل:علاقة الثقة بالنفس بالنجاح في 

النجاح فيه ذلك لان الشخص الذي  إلىالعمل من اهم العوامل المؤدية  أداءبالقدرة على  الإيمان إن

 داؤهأالعمل المطلوب  بأعباءينهض  إنبدوره  لا يستطيع الأداءيؤمن بقدرته على  أن لا يستطيع

 أنيع يستط التخاذل ،ومن ثم فانه لا إلىالعمل ينتهي به  أداءالشخص بالقصور عن  فإحساس منه،

يكون الشخص ملما بالعمليات المعرفية وبالمهارات  أنيكفي  العمل ،ولا لإنجازيبذل الجهد المطلوب 

بنفسه وبقدرته  بالأيمانيكون مشحونا  أنجانب ذلك واهم منه  إلىبل يجب  ،العمل لأداء اللازمة

 الثقة بالنفس إلىفي العمل بحاجة شديدة  وحتى الابتكار الأداءعلى 

 الهدي النبوي في الثقة بالنفس

ي والتراحم ف والمودةالمحبة  أساسوالمجتمع يقوم على  والأسرةمنهاجا كاملا للفرد  الإسلاموضع 

 النفسية.جميع مراحل الحياة الاجتماعية وفي جميع مجالاتها حفاظا على الصحة 

يمته بق وإشعارهتوكيد الذات  إلىالمحبة والتقدير والحاجة  إلىوالطفل منذ بداية حياته يحتاج 

لهم لبعث جوي الأطفالالاجتماعية. ولنا في رسول الله صلى الله عليه وسلم أسوة حسنة فقد كان يقدر 

حية أبا فلان وكان كذلك يلقي الت يا لأحدهمفيقول  الأطفالالثقة في نفوسهم ومن ذلك انه كان يكني 

حديث قال أنس بن مالك رضي الله عنه في ال الأطفالعليهم ويتجنب اللوم والانتقاد الكثير لتصرفات 

 لشيء وألم فعلت كذا  صنعته لشيءقال  ما علمتهالمذكور في صحيح مسلم )لقد خدمته تسع سنين 

 وكذا(تركته هلا فعلت كذا 

 

 



 

 

 

 

 

 

 

 

 

 

 

 :كيف نكتسب الثقة بالنفسوالان 

 هي:التي نبني عليها الثقة بالنفس  الأسسمن 

  بالإمكانياتو وبالأخرينالاعتماد على الله والتوكل عليه فمن الثقة بالله نستمد الثقة بالنفس. 

  الآخرين نقد أوجلد الذات فكلما بعدنا عن النقد الذاتي  أوالسلبي  كثرة النقدكذلك البعد عن 

ماركوس حاكم  ، يقولالإنجازات لا تقدرطبيعة شخصيتهم ناقدة  أشخاص اللاذع، فهناك

لكن  مأنفسهأنانين جاحدين يحبون  أشخاصاالرومانية الحكيم ذات يوم سأقابل  الإمبراطورية

 .أمثالهمالعالم من دون  يلأتخلا  لأنيمنزعجا من ذلك  أومندهشا  أكونلن 

  ذات كلما ازدادت ثقتنا بنفسنالوعدم النظرة السلبية ل الأخطاءوكلما بعدنا عن تضخيم 

 لم  يأصابنما  أناللهم رضني بقضائك حتى اعلم  الأثرفي  وشره: وردبالقدر خيره  الإيمان

 .........( هذاالمؤمن .... لأمريكن ليخطئني وما أخطأني لم يكن ليصيبني والحديث )عجبا 

  فقدان عزيز. أونا باي عقبات مرر إذامن شانه انه  الأمر

 ا يحدثمبما يحدث مثلما يتأثر برأيه حول  الإنسان لا يتأثرل الفيلسوف الفرنسي مونتين  يقو. 

 

 

 

 

 

 



 

 قود حياتي لأصنع النجاحدورة أ -2

 .. متعاونة قسم علم نفس أ/ أفراح المطيري 

 تعريف القيادة:

 .لجعلهم يتحمسون لبذل الجهود لتحقيق الطموح المشترك الآخرينفن تحفيز 

 صفات القائد الناجح:

 هدافه منظمه.وقته وأوراقه وأ أنائد منظمه كما عمال القفكل أ الدقة والتنظيم:

 .بل يصنعها الأحداثفالقائد الناجح لا ينتظر  صناعه الحدث والقدرة على اتخاذ القرار المهم:

 لأهدافاويتواصل معهم بمهارة ويوجههم لتحقيق  الآخرينيؤثر في  فالقائد الناجح :الآخرينفي  التأثير

 .المطلوبة

يه والى لولكنه يتقبل النقد الذي يوجه إ الآخرونيرى مالا يراه  أنيستطيع  فالقائد الناجح الرؤية الثاقبة:

 .المقترحة أفكاره

لمهام ومن يفوض ويحدد ا الأشخاصالتفويض في عمله فيعرف متى يفوض  يستخدم إليهالتفويض: 

 التي يمكن تفويضها.

 إمكانياتهومثقف على درجة عالية من الوعي والثقافة يطور من نفسه ومن قدراته  إنسانالقائد الثقافة: 

 ومهاراته بالقراءة والدورات التدريبية.

عملة ومسيرته نحو النجاح فلا يقدم سرعه  أثناءيراعي القائد الناجح المبادئ والقيم الالتزام الخلقي: 

 .وأخلاقهالنجاح الدنيوي على قيمه 

ين  ) :قال تعالىالقوة والأمانة:  ت  ال ق و ي  الأ  م  ي ر  م ن  اس ت أ ج ر  ه    إ ن  خ  ر  ا ي ا أ ب ت  اس ت أ ج  د اه م   (                                                                                                   ق ال ت  إ ح 

 (62)القصص: 

 

 

 

 



 

 

 الممارسات القيادية الخمس:

 التحدي             -5            الرؤية-4          التحفيز-3           التمكين-2القدوة       -1

 

 

 
 

 

 

 

 

 

 

 

 

 



 

 رياضيات:قسم ال لأنشطهموجز 

 ة(العاديفي الظروف  النقل التقليديةدراسة مشكلة ) بحوث العملياتنبذة عن علم ـ 1

 عبد الواحد .. أستاذ مشارك قسم الرياضياتد/ حامدين 

تعتبر بحوث العمليات من العلوم التطبيقية الحديثة التي حققت نجاحا واسعا في كافة المجالات    

 والمدنية حيث تستعمل في حل المعضلات الإدارية. ومنها العسكرية

 كلات واقعية حيثطرق علمية لدراسة مشهو علم يستخدم أساليب و تعريف علم بحوث العمليات:

نتمي العلم ي )وهذايمكن توفير أكثر من حل لها ويتم اختيار الحل الأمثل ضمن الإمكانيات المتاحة 

 .المتقطعة(الرياضيات  إلى

 المراحل الأساسية لتنفيذ بحوث العمليات في الواقع العلمي:

 .تحديد وتعريف المشكلة 

 . وضع النموذج 

 . حل النموذج 

 الحل . التحقق من صحة نتائج 

 . تنفيذ الحل 

تعتبر مشكلة النقل حالة خاصة من البرمجة الخطية والتي يمكن    :تعريف مشكلة النقل التقليدية

حلها بطريقة أكثر كفائة على طريقة السمبلكس بسبب طبيعة تكوينها وهي تعالج بصفة عامة مشاكل 

نقل البضائع وتوزيعها إلا أن هذا لا يمنع من استخدام نموذج مشكلة النقل بعد تعديله في حل مشاكل 

 يكون لها علاقة بالمواصلات ونقل البضائع . أنلتكوين ولا يشترط أخرى مماثلة من حيث ا

 :أنواع نماذج النقل

 :فيها مجموع العرض مع مجموع الطلبوهي النماذج التي يتساوى  نماذج نقل متوازنة. 

 وهي النماذج التي لا يتساوى فيها مجموع العرض مع مجموع الطلب  :نماذج نقل غير متوازنة

 .ارق وتكون تكاليف النقل فيها صفرف أو عمود وهمي ليستوعب الفوعندها يتم إضافة ص

 طريقة فوجل. -طريقة اقل تكلفة -طريقة الركن الشمالي الغربي طرق حل مشكلة النقل:

 

 



 

 مفهوم مشكلة التخصيصـ 2

 طالبات قسم الرياضيات بالكلية

والهدف منه اختيار ذج البرمجة الخطية ونماذج النقل تعد نماذج التخصيص حالة خاصة من نما

أفضل تخصيص أو تعيين وسيلة ما لإنجاز مهمة معينة بحيث تؤدي إلى الوصول إلى الحد الأدنى 

 (.)العوائد الأرباحمن التكاليف أو تعظيم 

 العملي:من الأمثلة على مجالات تطبيق نماذج التخصيص في الواقع 

 .تخصيص العاملين للعمل على آلات معينة 

  معينة.مهام وظيفية  لإنجازتخصيص الموظفين 

 .تخصيص عدد معين من المدراء على عدد معين من المناصب الإدارية 

 .تخصيص عدد معين من الآلات لإنتاج سلع معينة 

 .تخصيص وسائل نقل معينة لنقل السلع من مكان لأخر 

 أساسية:تستند نماذج التخصيص إلى أربعة شروط 

  عدد الوسائل أو الأشخاص أو الماكينات يساوي  أي والتسهيلاتوجود عدد متساو من العمليات

 عدد المهام.

  الوقت.عدم إمكانية الشخص أو الوسيلة من القيام بأكثر من عمل أو مهمة واحدة في نفس 

  ومحددة مسبقاكلفة أداء كل عمل أو مهمة من قبل )العامل أو الماكينة( معروفة . 

  رباحا أو تكاليف بالسالبأ والتي تمثلالمهام  لإنجازعدم السلبية إذ يفترض عدم وجود مبالغ. 

 :الحالات الخاصة لمشاكل التخصيص

 بالآتي:إذا كان الهدف من التخصيص تعظيم الأرباح أو كفاءة الأداء نقوم 

  يتم تحويل الحالة إلى حالة تقليل عن طريقة إيجاد الكلف النسبية.  حيث يتم إيجاد الكلف

قيمة فيها ثم نتابع الحل بالطريقة  أكبرالنسبية من خلال طرح كل قيم المصفوفة من 

 الاعتيادية.

 

 

 



 

 :قسم الفيزياء لأنشطهموجز 

 الـفيزياء الطبيةـ 1

 الفيزياءد/ رحاب أحمد .. أستاذ مساعد قسم 

هي إحدى فروع الفيزياء التطبيقية، فيها تطبق الفيزياء في المجال الطبي خصوصا في التشخيص 
 وعلاج الأمراض البشرية.

 
                      Medical physics 

 :فروع الفيزياء الطبية

 فيزياء علاج الإشعاعي Therapeutic Radiological Physics 

  فيزياء الطب النووي Medical Nuclear Physics 

  فيزياء الأشعة التشخيصية Diagnostic Radiological Physics    

 فيزياء الرنين المغناطيسي Magnetic Resonance Physics 

 فيزياء أجهزة الليزر Laser Physics 

 فيزياء الموجات الصوتية Ultrasound Physics 

 فيزياء الموجات الحرارية والعلاج الحراري Infrared and thermal therapy 

  (مثل تخطيط كهربائية القلب والدماغ)فيزياء الكهرباء الحيويةBioelectrical Physics 
 

ما هي 
مجالات 
اءالفيزي

الكهرباء

الطب

الاحياء

تالرياضياالهندسة

الفلك

الكمياء



 

 :الأجهزة الطبية المتعلقة بالفيزياء

 :/ جهاز تخطيط القلب1

 
 :/جهاز قياس الضغط2

 
 :(X-Ray)/ جهاز الإكس ري التشخيصي3

 



 

 :(MRI)/ جهاز الرنين المغناطيسي4

 
 :/جهاز الموجات فوق الصوتية5

 
هذه بعض الأجهزة التشخيصية المهمة والتي قائمه كليا على )الفيزياء( فلو حدث أثناء التشخيص 

مشكلة ما فلا يمكن للطبيب أو الفني أن يكتشفها لأنه درسها من ناحية طبية تشخيصيه وليس من 
 .طبية فيزيائيةناحية 

 

 

 

 

 



 

 بيئة أفضل(نحو ) بعنوانحملة  ـ2

 طالبات قسم الفيزياء بالكلية

ئب ابيئة نظيفة تخلو تماما من الشو  إيجاد إلىوالسعي  عنوان المجتمع المتحضرالنظيفة البيئة 
 وتقاليدها. أعراقهاليه مجمل الشعوب بمختلف والتشوهات مطلب حضاري تتطلع إ

 اظ على البيئة من التلوث:فكيفية الح

 التدوير إعادة 
  الطاقةتوفير 
 تقليل الاستهلاك 
 المواد إصلاح 
  صديقه للبيئة أجهزةاستخدام 

 المحافظة على الثروة الحيوانية والنباتية:

  الأشجارطع قالتقليل من 
 صيد الحيوانات المهددة بالانقراض معد 
 المحافظة على البيئات الطبيعية للحيوانات والنباتات 

 

 

 

 

 



 

  :الآليحاسب قسم ال لأنشطهموجز 

 PowerPoint  ـ1

Dr.Zulaikha Beevi 

Asst. Prof, Department of Computer Science 

As technology enters the classroom more and more each year, there 

are always innovations being brought into the fold that can help 

teachers to get their points across better, and help students learn more 

efficiently? One such tool that has been utilized in the classroom for 

some time now and continues to be used heavily is the Microsoft 

PowerPoint program. 

This program is one that enables teachers and students alike to 

prepare presentations. When used effectively, PowerPoint can really 

enhance teacher presentations and the overall comprehension of 

students. A program allows teachers to present their lessons in a more 

dynamic way than simply lecturing and writing on the blackboard. 

PowerPoint has become very popular because it's easy to learn and 

widely available. It provides the ability to equip your presentations with 

different types of media - including images, sounds, animations, and 

much more. This enhances the students' abilities to retain what they're 

being taught, especially those who are visual learners. Teachers can 

focus on the class and interacting with the students instead of writing 

on a board, because the text and the entire presentation is already 

there in the form of a PowerPoint file. 

PowerPoint is not just for the teachers though, another way to use 

PowerPoint in an educational setting is to have the students create their 

own presentations. This is a great way to teach them how to use visual 

aids while working on their presentation and public speaking abilities. 

 

 



 

 Create a Table ـ2

Dr.Zulaikha Beevi 

Asst. Prof, Department of Computer Science 
The following steps will help you understand how to create a table in a Word 

document. 

Step 1 − Click the Insert tab followed by the Table button. This will display a 

simple grid as shown below. When you move your mouse over the grid cells, it 

makes a table in the table that appears in the document. You can make your 

table having the desired number of rows and columns. 

 

Step 2 − Click the square representing the lower-right corner of your table, 

which will create an actual table in your document and Word goes in the table 

design mode. The table design mode has many options to work with as shown 

below. 

 

Step 3 − This is an optional step that can be worked out if you want to have a 

fancy table. Click the Table Styles button to display a gallery of table styles. 

When you move your mouse over any of the styles, it shows real time preview 

of your actual table. 

 

 



 

 

 

Step 4 − To select any of the styles, just click the built-in table style and you 

will see that the selected style has been applied on your table. 

 

 

Delete a Table 
Following are the simple steps to delete an existing table from a word document. 

Step 1 − Click anywhere in the table you want to delete. 

Step 2 − Click the Layout tab, and click the Delete Table option under 

the Delete Table Button to delete the complete table from the document along 

with its content. 

 

Add a Row 
Following are the simple steps to add rows in a table of a word document. 

Step 1 − Click a row where you want to add an additional row and then click 

the Layout tab; it will show the following screen. 

 

 



 

 

 

Step 2 − Now use the Row & Column group of buttons to add any row below 

or above to the selected row. If you click the Insert Below button, it will add a 

row just below the selected row as follows. 

 

 

If you click the Insert Above button, it will add a row just above the selected 

row. 

Delete a Row 
The following steps will help you delete rows from a table of a Word document. 

Step 1 − Click a row which you want to delete from the table and then click 

the Layout tab; it will show the following screen. 

 

 

Step 2 − Click the Layout tab, and then click the Delete Rows option under 

the Delete Table Button to delete the selected row. 

 



 

 

 

 

 

Add a Column 
The following steps will help you add columns in a table of a Word document. 

Step 1 − Click a column where you want to add an additional column and then 

click the Layout tab; it will show the following screen. 

 

 

Step 2 − Now use the Row & Column group of buttons to add any column to 

the left or right of the selected column. If you click the Insert Left button, it 

will add a column just left to the selected column as follows. 

 

 

If you click the Insert Right button, it will add a column just next to the 

selected column. 



 
 

 اللغة الإنجليزية:قسم  لأنشطهموجز  .3

 Basic English  ـ1
Rasha Mohammad Aljazzar 

Lecturer, Department of English Science  
The Main Uses of Capital Letters: 

1. At the beginning of the sentence. 

2. The pronoun “I “.  

3. Names of people, countries, cities, villages, and abbreviations.  

4. Names of holidays, months, days, and seasons. 

5. Nationalities, languages, and titles of books, films and magazines. 

6. Names of seas, lakes, oceans, streets, buildings and parks.   

Days of the week: 

 
 



 

Months of the year: 

 
 

 
 

 

 



 

Basic colors:  
what is your favorite color?         What color is this? It is …………… 

 
Family Members: 

 
 

 

 



 

 بالكلية زيارة مدرسه ثانويه لتوعية الطالبات بالأقسام المتاحة-2

Rasha Mohammad Aljazzar 
Lecturer, Department of English Science  

 

عريف لتمدرسة ثانوية مع منسقه القسم أ/ رشا الجزار زارت مجموعه من طالبات قسم اللغة الإنجليزية 

ليزية )فرع البدائع( وهي قسم اللغة الإنج المتاحة بكلية الآداب والعلوم بجامعه القصيم بالأقسام الطالبات

وشعبه علم النفس، كما قامت بالرد على جميع أسئلة واستفسارات  الآليوالرياضيات والفيزياء والحاسب 

 لأخذااختيار التخصص المناسب بعد  كيفية ومن بين النقاط التي نوقشت في هذا اللقاء هو الطالبات،

 العمل.الجوانب مثل شغف الطالبة وقدراتها ومؤهلاتها ومطالب سوق بعين الاعتبار العديد من 

 

 

 

 

 

 

 

 

 



 

 المجتمعفي خدمه النفس  علمقسم  دورتفعيل         

 د/ رانيا الصاوي عبده عبد القوي

 أستاذ الصحة النفسية المشارك

 

 

 

 

 ة،الاستراتيجيلها برامج عديده ي خطتها  وأفردتمن رسالتها  أساسيالقد جعلت جامعه القصيم خدمة المجتمع جزءا 

ي تسهم والفعاليات النوعية الت والأنشطةوتعتبر عمادة خدمة المجتمع البوابة التي تدلف منها الجامعة لتنفيذ البرامج 

 في تطوير المجتمع وتنميته ثقافيا واجتماعيا واقتصاديا وصحيا وعزيز التنمية المستدامة له.

 الاتي:من خلال  الجامعةنفس في القيام بتنشيط دور ولذلك يسعى قسم علم ال

 تفعيل دور قسم علم النفس في الكلية لخدمة طالباتها والمجتمع المحلي.-1

عقد المزيد من اللقاءات العلمية والندوات المتخصصة لقسم علم النفس ولمؤسسات التعليم في المجتمع المحلي بهدف -2

 تنمية وتوعية المجتمع.

 ارد البشرية المؤهلة القادرة على خدمه المجتمع.تنمية المو-3

 

 

 

 

 

 



 

 

 الرياضيات وأهميتها للفرد والمجتمعقسم            

  د/ حامدين عبد الواحد .. أستاذ مشارك قسم الرياضيات

 
 

قدرة و                                                                                                   الرياضي ات لها دور كبير في اكتساب سمات إيجابية للشخص كتعلم التنظيم، والدقة، والموضوعية، والمثابرة، 

                                                                                                            الحكم بالمواقف، واحترام الرأي الآخر، واستغلال الوقت باعتباره ثمينا  في التعلم. استخدام أسلوب علمي في التفكير، 

                                                                                                    فهي مادة علمي ة وتساعد ذهن الإنسان على التفكير في جميع نواحي الحياة بأسلوب علمي، وهو أحد أفضل أساليب 

                                                                 وف في علوم الرياضي ات بأن ها لا تعتمد على طريقة حل واحدة، بل يمكن التفكير. القدرة على الابتكار، فمن المعر

نستطيع  ليها بنفس الطريقة الأولى، وهذا يعني أنناإوصول إلى نفس النتيجة التي وصلت ابتكار طريقة تستطيع بها ال

  .                                             من خلال الرياضي ات ابتكار أمور كثيرة في حياتنا

الأعداد  وبدون ،ة الحياة المنظمة ليومنا الحاضرفهي دعام ،مكملة للغة الطبيعةسيلة عالمية تعد الرياضيات لغة ووو

، معدلات ،ساتقيا ،فهناك توقيتات ،مسائل عديدة في حياتنا اليومية فأننا لا تستطيع أن نحسم ،ئل الرياضيةوالبدا

الرياضية علينا أن يانات وفي غياب هذه الب ،استهلاك ... إلخ ،صرافة ،تعاقدات ،أسهم ،وظائف ،مناقصات، أجور

  والارتباك والفوضى ،نواجه التشوش

اد الإنسان فعندما أر ،له منذ وجود البشرية على الأرض والمساعد ،الرياضيات الرفيق الوفي للإنسانلذلك أصبحت ف

لجبر اوبعد ذلك تم ابتكار علم  ،اخترع علم الحساب ،... إلخ حجم؟؟ ما : كم عددي البداية الإجابة على أسئلة مثلف

ما أراد وظهر علم حساب المثلثات عند ،فقد تم ابتكار علم الهندسةأما القياسات والأشكال  ،لتسهيل العمليات الحسابية

  .الإنسان تحديد مواقع الجبال العالية والنجوم

، علم وليس هناك ،ريق أو بآخرمد على الرياضيات بطفكلها تعت ،ضيات ضرورية لفهم العلوم الأخرىكما أن الريا

حجم ب وأن ضبط وإتقان أي علم أو فن آخر يرتبط بدرجة كبيرة ،                             إلا وكانت الرياضيات مفتاحا  لهأو فن أو تخصص 

 .ولذلك تسمى الرياضيات بملكة العلوم وخادمتها في نفس الوقت، الرياضيات التي ينتفع بها

 ويستخدم كل فرد الرياضيات بصورة مباشرة أو غير مباشرة من ،لية                   وثيقا  بحياتنا العم ارتباطاوترتبط الرياضيات 

 والرياضيات أحد أهم المواد الدراسية التي تقدم للطلاب للمساهمة في تحقيق الأهداف التربوية، اليومية خلال حياته

                                  تقريبا  من أي برنامج تربوي تعليمي  %22فالرياضيات كمادة تمثل عادة في حدود  ،التي تسعى المدرسة إلى تحقيقها

                                                                                                   بالنسبة للمواد الأخرى مما يجعل البحث عن جدوى مساهمتها في تحقيق أهداف أي برنامج تعليمي أمرا  في غاية 

 .الأهمية

https://cu.edu.eg/ar/Cairo-University-Faculty-News-7009.html


. 

 في خدمة المجتمع الفيزياءقسم        أهمي ة 

 يزياءد/ رحاب أحمد .. أستاذ مساعد قسم الف

 
 

                                                                                                          يمكن القول أن  سبب التقد م الكبير الذي شهدته الحضارة الإنساني ة في القرون الأخيرة يرجع بشكل أو بآخر إلى علم 

                                                                                                           الفيزياء، خاص ة بعد إيجاد قوانين الحركة للعالم إسحاق نيوتن، وبعد اكتشاف المبادئ التي ب نيت عليها العديد من 

ستغناء عنها كوسائل الاتصالات، والأجهزة الطبية التي استطاعت إنقاذ                                        الأجهزة التي لم يعد الإنسان قادرا  على الا

-                                                                                                         العديد من أرواح البشر الذين يعانون من مختلف الأمراض. من العلوم التي تتقاطع بشكل كبير جدا  مع علم الفيزياء 

 لوكياتهاوسهر الطبيعية                                                  علم الرياضيات، والذي ي عتبر سبب  تحويل معظم الظوا هو-       رائعة                         بحيث يشكلان معا  توأمة  

ي غ رياضية هام ة تخدم حاجة الإنسان إلى التنبؤ بهذه الظواهر، وقد أسهم عدد كبير من                                                                                                         المختلفة إلى معادلات وص 

                                                                                                             العلماء في هذا المجال المعرفي الهائل على مر  الإنساني ة مم ا أوصل علم الفيزياء إلى هذا المستوى الراقي الذي هو 

 اضر.عليه في الوقت الح

مكان تتواجد فيه التكنولوجيا يجد الفيزيائي عمل له ويكون مفضل عن غيره لما يمتلكه من معلومات  أيفي ونجد انه 

 .أسرعوالخبرات الذاتية التي تؤهله للتعامل مع التكنولوجيا وتطورها بشكل  الأساسيةعن المبادئ 

يعتمد  التشخيص في المستشفيات أجهزةكل  أنحيث  الذي يخدم المجتمع يعمل في المجال الطبي أنفيمكن للفيزيائي 

 وأشعةية فوق الصوت والأمواجاكس والنظائر المشعة والرنين المغناطيسي  أشعةتشغيلها على الفيزياء مثل استخدام 

 .الفيزيائيين وأبحاثالمستخدمة والتي هي تطبيقات لاكتشافات  الأجهزةالليزر والمنظار وغيرها من 

كما وان  ،الإلكترونياتفروع الفيزياء وهو  أحدالصناعية الذي يعتمد على تطور  والأقماركذلك في مجال الاتصالات 

 أساسياا للفيزيائي دور أنالجوية ومراكز التنبؤ بالزلازل ومراكز البحوث كما  الأرصاد                            علم الفيزياء ضروريا  لمراكز 

 مشوار التقدم العلمي. للإكماجديدة  أجيال لأعدادفي مجال التعليم 

 

http://www.google.com.sa/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwiM8smGnprXAhVHcRQKHS7ACO4QjRwIBw&url=http://sciencesf.kku.edu.sa/ar/content/156&psig=AOvVaw16OQi3ejX8ao9x4nr9n1ez&ust=1509517597381016


 

 خدمة المجتمعأهميته في و الإنجليزية اللغةقسم 

Rasha Mohammad Aljazzar 
Lecturer, Department of English Science  

 

 
 

دمه حيث تتجلى هذه العلاقة بما يق المجتمع.هناك علاقة وثيقة بين قسم اللغات ممثل بقسم اللغة الإنجليزية وخدمة 

للغة ت ترجمة من وإلى اوالتي تتضمن تقديم خدما الخدمات.القسم من مخرجات تعليمية ترفد المجتمع بشتى أنواع 

 الأساليب التعليمية والتربوية جيل من المعلمين قادر على تدريس أبناء الوطن باستخدام احدث إنشاءوالعربية 

مع المحلي المجت إلىاطات الترفيهية والتي تتضمن التواصل مع الثقافات الأخرى ونقلها المشاركة في شتى النشو

لتداول تسوده اللغة الإنجليزية ازية للمجتمع في المجال التجاري وسوق الأعمال وخدمة اللغة الإنجلي أيضاتكمن و

 ب فئات و شرائح المجتمع لغتهالا ننسى في هذا المقام وسائل التواصل الاجتماعي الحديثة التي يستخدمها أغلو

للغة اأصبحت لغة التواصل العالمي و التيالأساسية هي الإنجليزية لذا فإنه من المهم تثقيف المجتمع بتلك اللغة 

 .الجامعة للعالم ككل

 لمجتمع تقديم مختلف الخدمات إلىيسعى قسم اللغة الإنجليزية والترجمة بالبدائع  القصيم،وكقسم فعال في جامعة  

ل إقامة حد سواء من خلا على والموظفاتحيث انه يساهم برفع والنهوض بمستوى اللغة الإنجليزية للطالبات  الكلية.

وركزت هذه الدورات على مكانة اللغة الإنجليزية في عصرنا هذا   باللغة الإنجليزية. وتأسيسيةدورات تدريبية 

  والمعرفة.بوصفها بوابة دخول لشتى أنواع العلوم 

 

 

 

 

http://www.google.com.sa/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwjX0vOBn5rXAhUE6RQKHS0KBhAQjRwIBw&url=http://www.egylearn.com/learn-english-for-all-dialogues/&psig=AOvVaw3r7fk75v3WDafjJVbficUu&ust=1509517961165019


 

World is very Closer to You 

Dr.Zulaikha Beevi 
Asst. Prof, Department of Computer Science 

 
 

Language is needed for any kind of communication, even people with speech 

impairments communicate with sign language and brail. Communication 

becomes difficult in situations where people don't understand each other's 

language. The inability to communicate using a language is known as 

language barrier to communication. 

Language barriers are the most common communication barriers, which cause 

misunderstandings and misinterpretations between people. 

Most of the people in the world do not speak English or, even if they use, it is 

their second or third language. If the speaker and receiver do not use same 

language and words, there is no meaning to the communication. Not using the 

words, that other person understands makes the communication ineffective 

and prevents message from being conveyed. 

 

This Portable Language Translation Device is one of the best translator 

devices that functions as if it’s come out of a futuristic sci-fi novel. 

 

Before travelling somewhere new you probably always try to find the best 

translator app for your phone, just to be safe. 

https://www.businesstopia.net/communication
https://awesomestuff365.com/futuristic-flying-cars/


 

 الخاتمة

بأصدق المشاعر وبأشد الكلمات الطيبة النابعة من قلب صادق أقدم شكري وامتناني لمن 

ي نكون موفقين ف أنكانوا سبب في استمرار واستكمال هذا الجهد المتواضع، الذي أتمنى 

 مسرد العناصر سردا لا ملل فيه ولا تقصير حيث تختص هذه الوحدة بالتخطيط والتنظي

لتنفيذ أنشطة خدمة المجتمع المقدمة من الكلية ومنسوبيها بهدف الارتقاء بالخدمات المجتمعية 

 التطويرية والتوعية من اجل توظيف دور الجامعة في خدمة المجتمع،

بأهم إنجازات وحدة خدمة المجتمع  وأدليناعرضنا  إننا قدأقول  أن إلا كلوفي الختام لا ام

وفقنا في هذا ولعلنا نكون قد  هـ،1431-1438( لعام 381ي الأول )في الفصل الدراس

 نأبشر قد نخطئ وقد نصيب فنسال الله العلي القدير  إلا نوما نح، العرض والتعبير عنه

 يوفقنا ويلهمنا الخير والسداد.

 

   

 

 


